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1. Introduction

HydraMotion is a simulation software package that provides an accurate working simulation of hydraulic
devices and circuits. It enables students to study and understand the principles of hydraulics.

As a design tool, HydraMotion allows students to create, operate and observe a model circuit. The
circuit can be printed, altered and improved as needed.

HydraMotion can be used in conjunction with the HydraFlex work panel, on which an actual circuit with
working components can be assembled and operated.

1 Introduction

2.1 System Requirements 1
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2. Installation and Activation

2.1. SYSTEM REQUIREMENTS

e Hardware requirements:

Pentium 4 Dual Core with 3 GHz processor or higher, with CD drive
At least 512 MB RAM (1 GB for Vista)

A hard drive with at least 100 MB of free disk space

A VGA or better graphics display, minimum 256 colors

A Mouse or other pointing device

Separate RS232 ports on the PC-for each hardware device which uses an RS232 port (or
USB ports with RS232 — USB adapter)

e Software requirements:

One of the following Windows 32 or 64 bit operating systems:
Windows XP Professional

Windows Vista (Home Premium/Business/Ultimate editions)

Windows 7 (Home Premium/Professional/Enterprise/Ultimate editions)
Windows 8/8 Pro/8 Enterprise

Windows 8.1/8.1 Pro/8.1 Enterprise

2.2. INSTALLING THE SOFTWARE

This section describes how to install the HydraMotion software. You can obtain your license from
intelitek's website at the end of the installation.

See the Intelitek Software Licensing Guide supplied on your installation CD for other methods of

registration.

2 Installation and Activation

2.2 Installing the Software 2
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To install the software, do the following:

1. Start Windows.

2. Close any open applications before you begin the installation. If you are about to reinstall the
software or install a newer version to an existing HydraMotion directory, it is recommended that
you backup any existing user-created files before you begin the installation. It is also
recommended that you remove the previous HydraMotion installation by means of the Uninstall
utility included with the software.

3. Insert the CD into the CD-ROM drive. The installation should begin automatically. If it does not,
run HydraMotionSetup.exe from the CD-ROM \Install folder. The welcome screen is shown.

sy S ==

Welcome to the Install5hield Wizard for HydraM otion

2 Installation and Activation

2.2 Installing the Software 3
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4. Click Next. The License Agreement is shown.

HydraMotion Setup

License Agreement
Pl =5 the f

LICEMSE AGREEMEMT -

LICEWSEE [REFERRED TO IN THIS AGREEMENT AS "vOU'") AGREES “WITH THE
LICENSOR, [INTELITEK, INC.]. [REFERRED TO IN THIS AGREEMENT &S "INTELITEK")
TO THE TERMS AMD COMDITIONS SET FORTH IN THE FOLLOWING LEGAL
AGREEMENT. THIS AGREEMEMNT IS AN ELECTRONIC AGREEMENT AND IS A
LEGALLY BIMDING COMNTRACT.

IMPORTANT - THE SOFTWARE 15 LICEWSED OMLY OWN THE CONDITION THAT THE H

B CLICKIMG ON THE | ACCEPT BUTTON BELOW, YO CONSEMT TO ENTER INTO
THIS AGREEMEMT AND ACCEPT AND AGREE TO BE BOUMD B ALL THE TERMS OF
THIS AGREEMENT.

IN SUCH EVENT. v'OU WiILL BE PERMITTED TO ACCESS THE SOFT'WARE. IFY0OU DO
NOT ACCEPT AMD AGREE T0 EE BOUND BY THE TERMS OF THIS AGREEMENT., vOU
MUST IMMEDIATELY CEASE INSTALLATION OF THE SOFT'WARE AMND YOU WILL NOT
BE PERMITTED TO ACCESS THE SOFTWARE.

1. Grant of Licenze

Subject to the terms and conditions et out in thiz License Agreement, Intelitek grants Youa -

b T

Ti i ——

2 Installation and Activation

2.2 Installing the Software
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6. Select the Controller Type and click Next. The Interface Language is screen is shown.

ConrolerbpeDidog 5 ==

Setup Type
t th

S —

Englizh

7. Choose your desired language and click Next. The Choose Destination Location screen is shown.
By default, the software is installed to the folder C:\Intelitek\HydraMotion. During the
installation process you have the option to change this. It is not recommended that you do so.

Hydraotion Setup e T

Choose Destination Location
falder whe

2 Installation and Activation

2.2 Installing the Software 5
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8. Click Next. The Select Program Folder screen is shown.

iMooy  ——— ==

Select Program Folder

7 -t a program folder.

Tou may tepe a r

Broadband
Camtasia Studio &

Canah

DATA POZ EVDO Madem
Davka

Digsby

DD MovieFactory for TOSHIBS
Extraz and Upgrades

9. Click Next. The Setup Status screen is shown. When the status bar completes the InstallShield
Wizard Complete screen is shown.

HydraMotion Setup

InztallShield Wizard Complete

Th h 2 Hydrakd ation.

2 Installation and Activation

2.2 Installing the Software 6
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10. Click Finish to exit the InstallShield Wizard.

When the installation is complete, the HydraMotion icons will appear.

. HydraMotion
= HydraMotion
£ Unlnstall HydraMotion

2.3. UNINSTALLING THE SOFTWARE

This section describes how to uninstall your software. Before you uninstall the software, you should
backup any existing user-created program and position files.

@ Note: If required, before you uninstall the software you can return your license to Intelitek (and
retrieve it later). For further details refer to the Intelitek Software Licensing Guide supplied on
your installation CD.

To uninstall HydraMotion, do the following:

1. From your windows Start menu, select All Programs | HydraMotion A popup menu is displayed.

. Hydrafotion
*= HydralMotion
& Unlnstall HydraMotion

2. Select Uninstall HydraMotion to remove your HydraMotion software components and follow
the instructions that appear on the screen.

2.4. ACTIVATING THE SOFTWARE

To start HydraMotion, do the following:

1. If you will be using HydraMotion with a HydraFlex panel, make sure that all hardware has been
properly set up and connected according to the installation procedures detailed in the user
manuals.

2. Turn on the computer and all other connected hardware.

3. From your Windows Start menu, select All Programs | HydraMotion. The following popup menu
is displayed.

, HydraMotion
*= HydraMotion
£ Uninstall HydraMotion

4. Select HydraMotion. The HydraMotion application window is displayed.

2 Installation and Activation

2.4 Activating the Software 7
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A T —

mmmmmmmﬂmm

il i Bed I (= e

L [CEFS |[OvR [REC !I
2.5. QUITTING THE SOFTWARE

To quit HydraMotion, use any of the standard Windows methods for closing a program:

1. In HydraMotion, select File | Exit.

2. Double Click the Control-Menu box in the Title Bar.

2 Installation and Activation

2.5 Quitting the Software 8
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3. Overview

3.1. THE HYDRAMOTION WINDOW

The elements of the main HydraMotion window are shown in the following diagram:

Tl B 1 O -

Menu Bar i€ Edit View Components Connections Simulation Interface Window Help
Tool Bar Eﬁlinél ﬂl| @l 5@1$+| Fl@ E]'*l]l

Drawing Window

Status Bar [CaPs [OvR [REC

Title Bar

Menu Bar

Tool Bar

Drawing Area

Contains the usual Windows controls for sizing and closing
the application screen as well as an additional option
enabling you to display the interface on top at all times.

Contains menus with HydraMotion commands. Some
commands are accessible from the tool bar (buttons), while
some are accessible only in the menus.

Contain buttons that represent the most frequently used
functions and commands. Button availability varies
according to the currently active screen or mode, or the
selected component.

Screen area used for designing and displaying circuits

3 Overview

3.1 The HydraMotion Window
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3.2. FILE MENU

ey Crl+M
Open... Ctrl+0
Save Ctrl+5
Sawe & .,
Pririt... Ctrl+P
Delete...
Exit

[LE]

=

By

=1

Status Bar

Displays, at the bottom of the screen, information
regarding the HydraMotion software, modes of operation,
current activity, and so on. When you position the mouse
over an icon, a description of the icon appears in the status
bar.

The File menu contains the usual Windows functions which allow you to load, save
and print files containing hydraulic circuit diagrams and connections, and to exit

the software.

Only one file can be opened and edited at a time; however you may

open a second window to create and edit a second file.

[New [Ctrl]+N

| Open [Ctrl]+O

|save [ctri}+s

| Save As...

| Print [Ctrl]+P

| Delete...

| Exit

Opens a new, untitled file.

Opens an existing file.

Saves the currently active file.

Saves the currently active file under a new file
name.

Prints the currently active file.

Deletes a previously saved file.

Quits HydraMotion.

If changes have been made to a file, but not yet
saved, a warning message will be displayed.

For more information on file management, see Chapter 8.

3 Overview

3.2 File Menu

10
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.3. EDIT MENU

rmCDpy e The Edit menu contains usual Wi.ndows functcions found in m<.)st fjrawing
programs. These allow you to edit cross section and schematic diagrams.
Duplicate 5
Rotate Right Fi
Rotate Left Ctrl +R
irrar Fa
Flip Fg
Delete Del
Description Shift+F1
Pararmeters !

|c°pV [Ctri]+C | Copies a selected component to the clipboard
as a regular drawing object. It can then be
pasted into any other program.

E]"'E]I |D“p"°ate | Makes a copy of the selected component.
EI | Rotate Right  F7 | Rotates the selected component 90° to the

right.

| Rotate Left | Rotates the selected component 90° to the left.

[ Mirror F8 | Reverses the selected component horizontally,
so the left becomes right and vice-versa.

§| | Flip F9 | Reverses the selected component vertically, so
the top becomes the bottom and vice-versa.

| Delete [Del] | Deletes the selected component.

| Parameters ! | Sets values for selected components. This

option is only available for those components
which have variable parameters.

For more information on editing functions see Chapter 4.

3.4. VIEW MENU

v Cross-Section

The view menu contains the commands for the viewing modes available
in HydraMotion.

schematic

Ladder Diagram Lol
Pararmeter Diagram

Zoorn In

Zoom Out Ctrl+Z

3 Overview

3.4 View Menu 11
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=

|C"°55 Section | Displays a cross section view of each

component.

|5°hematic | Displays the components in standard schematic

form.

| Ladder Diagram | Opens a schematic control flow chart for

electro-hydraulic circuits.

| Parameter Diagram | Opens a dialog to monitor pressure and flow

during circuit operation.

|zoom In | Magnifies the current view.

| Zoom Out [Ctrl]+Z |

[ F = &

Returns the view to normal.

For more information on viewing see Chapter 6.

3.5. COMPONENTS MENU

[Qomponents . .
: The Components menu contains the commands for selecting the
List Ctrl +F2 . . .
_ HydraMotion Component List and Library.
Librany F2
|Li5t [Ctri]+F2 | Opens a list of the HydraMotion components
organized by category.
1] -
B | Library F2 | Opens a graphic library of the HydraMotion

components and devices.

For more information on selecting components see Chapter 4.

3.6. CONNECTIONS MENU

Connect Components F&

The Connections menu contains the commands for connecting

components in HydraMotion.
Delete All Connections

Link PB:s Ctrl+F3
Clear PB Links
Create Ladder Diagram

E Connect Components | gelects the Connect Components view.
F5

|De|ete All Connections | Deletes all connections in the circuit.
|Link PBs | Links two or more push button switches

together.

3 Overview

3.6 Connections Menu 12
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|CIear PB Links | Disconnects any PB links in the circuit.

|Create Ladder Diagram | Creates or edits a ladder diagram for electro-
hydraulic simulations.

For more information on making connections see Chapter 5.

3.7. SIMULATION MENU

T = The Simulation menu contains the commands for simulating a pneumatic
e circuit, and individual components in HydraMotion.
Cormponent b
m |Ci"°“it Selects the HydraMotion simulation feature.
Simulation is available only when the Cross- Section
display mode is active.
E Component Activates the simulation of a component.

For more information on simulation modes see Chapter 7.

3.8. INTERFACE MENU
[Interface |

Setup #
Display /0
COM Test

The interface menu contains the commands for online software operation.

|Setup # I Configures the hardware and software for online
operation.

| Display 1/0s | Provides graphic tracking of the inputs and outputs
during online operation.

|C0M Test | Tests communication between the hardware and
software.

For more information about on line operation, see Chapter 9.

3 Overview

3.8 Interface Menu 13



Intelitek»»

Dynamic Solutions, Inspired Classrooms

3.9. WINDOW MENU
(Windlow]
Dpen Main Window
Close Main Window
Open 2nd Window
Close 2nd Windoa

The Window menu defines how the windows containing circuit diagrams are
displayed on the screen.

Cascade
Tile
Arrange Icons
Close All
v 1lntitled 1
]ILI |Open Main Window | Opens a new main window.
]ILI |Close Main Window | Closes the main window if it is open.
- |Open 2nd Window I Opens a new second window.
plEs| |Close 2nd Window | Closes the second window, if it is open.
|Cascade | The usual Windows control for resizing and layering
open windows so that each title bar is visible.
|Ti|e I The usual Windows control for resizing and arranging
the open windows by size.
|Arrange Icons | The usual Windows control for realigning the icons of
programs that have been minimized.
|C|°59 Al | Closes all open windows that are used for program
editing.

The Cascade or Tile setting remains in effect until changed.

3 Overview
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3.10. HELP MENU

[Help

Ahout...

Registration...

About

Registration

The Help menu contains commands for viewing the software version information
as well as the software licensing options.

Opens the About HydraMotion dialog box containing
the current software version information.

Opens the License window enabling you to see your
license status.

In order to see the Registration dialog box, you need to
run the application as an administrator. This enables
you to perform various registration options, such as
obtaining and retrieving your software license from
Intelitek’s web site, e-mail, fax or phone.

3 Overview

3.10 Help Menu
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4. Components

The Components menu allows you to select components and include text in your circuit diagrams.

You can perform the following functions on components which have been placed in the drawing area:

e Move e Rotate
e Flip e Resize
e Delete e Copy

4.1. SELECTING COMPONENTS

To view and place components in a circuit diagram, use either of the following:
Component List dialog

Components Library

4.1.1. The Component List

Select Components | List or click the Component List button. The component list dialog box opens.

To place components from the list into the drawing area, do the following:

1. Select a category from the Groups list.

(If you double click on one of the category names, the component library (graphic display)
appears.)

2. Select a components list.

4 Components
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3. Click OK.

4. Click on the drawing area. The component appears at the point where you click on the drawing
area.

5. When you have finished placing the components in the drawing area, click Cancel.

4.1.2. The Component Library

=M
o

Select Components | Library, or click the Component Library button.

The Components window opens.

5| Components  [s53e

“Thas

FOWER-FACK || | FRESSURE

-

ae ov

GERR FUMF| | FRESSUERE

= |
-

PISTON SEQUENCE

I =

TRNE 'PRESSTRE
1| 1 | 3

The components are shown either in cross section or as schematics depending upon the currently active
display mode.

You can move and resize the Components window, if necessary. You may need to use the horizontal
scroll bar at the bottom of the window to find the component.

To place components from the library into the drawing window do the following:

1. Click on the picture of the component you want to use.

2. Click on the drawing area. The component appears at the point where you click on the drawing
area.

The placement does not have to be exact; you can move components after you have placed
them in the drawing area.

3. When you are finished placing the components in the drawing area, click anywhere in the
drawing area to close the Component Library.

4 Components
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4.2. MANIPULATING COMPONENTS

Once you have placed components in the drawing area, you can manipulate and arrange them.
To select a component, simply click on it.

A frame with handles is drawn around the selected component.

4.2.1. Moving Components
To move a component, do the following:

1. Click on the component. A frame will be drawn around it.

2. Click and drag the component to the desired location.

| ==

4.2.2. Rotating Components

G E

To rotate a component, do the following:

1. Click on the component. A frame will be drawn around it.
2. Select Edit | Rotate Right or Edit | Rotate Left.

OR
3. Select the Rotate Right, or Rotate Left button.

4. The component is rotated 90° to the right or left.

4 Components
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4.2.3. Flipping Components

To flip a component, do the following:

1. Click on the component. A frame appears around the component.
2. Select Edit | Flip OR click on the Flip button.

The component is flipped over. The top and bottom sides are reversed.

4.2.4. Mirroring Components

To mirror a component, do the following:

1. Click on the component. A frame appears around the component.
2. Select Edit | Mirror OR click on the Mirror Button.

The component is mirrored. The left and right sides are reversed.

4.2.5. Resizing Components

To resize a component, do the following:

1. Click on the component. A frame appears around the component.
2. Place the mouse on one of the frame handles.
The cursor changes to a double arrow.
3. Click and drag the handle to readjust the size of the component.
OR

4. Use the + and - keys to resize the selected component.

4.2.6. Copying Components

To copy a component in the circuit diagram, do the following:

1. Click on the component. A frame appears around the component.
2. Select Edit | Duplicate, or click the Duplicate button.

A copy of the component appears on top of the original component. The duplicate component is now
selected, and can be manipulated.

You can orient, move, or resize the copied component as needed.

4 Components
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The File | Copy command places the selected component on the Windows clipboard. This allows you to
be paste a component into another application as a graphic object. It does not make a copy of the
component in the circuit diagram.

4.2.7. Deleting Components

To delete a component, do the following:

1. Select the component you want to delete.

2. Select Edit | Delete, or click on the Delete Object button; you are prompted to confirm.

Delete Object? =5

SINGLE ACTING CYLINDER

3. Click Yes to delete the component.

4.2.8. Adding Text
HydraMotion allows you to add text to your circuit drawings. To add text, do the following:

1. Select either the Components List or the Components Library.

2. Select the Text object, in the list or library.

3. Place the text object anywhere in the drawing area.

4. Close the list or library.

5. Select the text object, if not already selected.

6. To enter text in the Input Text dialog box do one of the following:
= Press [Enter].
= Double click on the text object.

7. Replace “TEXTO” with the text you want to appear in the circuit diagram.
Insert Text ﬂ

[rExTd]

8. Click OK.

4 Components
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9. The text will be displayed in the drawing window.

10. The text now appears as an object in the diagram. You can manipulate it in the same way as any
component. Text cannot be flipped horizontally or vertically.

4.3. COMPONENT PARAMETERS
4.3.1. Editing Component Parameters

HydraMotion allows you to set values for a number of components. To set the component parameters
do the following:

1. Select the component whose parameters you want to view or change.

2. Select Edit | Parameters, or click on the Component Parameters button, the Input Parameter
dialog box opens.

If more than one variable appears in the list, select the one you want to view or change.

3. The current value of the selected variable is displayed. You can change this value by typing a new
value, or by selecting a value by means of the scroll bar under the field.

4. Click OK.

Pararmeters @

D &)1 aniables
/o

d[rn]
=N FIIImFHEE[KN]

Parameters ﬁ

W alvePozition &l anables

—
it WalvePosition[%Z]

EX [ N
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5. Connections

Components and devices are connected on the screen by means of colored lines which represent
pneumatic and electrical connections.

Once components are connected, they cannot be rotated, flipped, or resized; they can however, be
moved or deleted.

Deleting a connected component will also delete all lines connected to it.

5.1. CONNECTING COMPONENTS

5.1.1. Making Pneumatic Connections

[

To connect components do the following:
1. Select Connections | Connect Components, or click the Connect Components button.
A grid of dots appears in the drawing area, indicating that components can now be connected. In

addition, black boxes with white borders appear at component ports where connections can be
made.

File Edit View Components Connections Simulation Interface Window Help

[Cars |[ovR |[REC I

2. Point the mouse on an available port. The border turns green, indicating a connection can be
made.

3. Click the mouse, a blue arrow appears indicating the first port has been selected.

Optional: you may route the connection between an inlet and an outlet by clicking the mouse to
make right angle turns along the route. A red line will mark the path as you create it. You can use
this option to route lines around a component.

5 Connections
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4. Bring the cursor to the second port. The border turns green.

5. Click the mouse, a light blue line now connects the two components.

5.1.2. Making Electro-Pneumatic Connections

[

Connecting electronic components is similar to connecting the pneumatic components.
To connect electronic components do the following:

1. Select Connections | Connect Components, or click the Connect Components button.

Electronic components have colored circles to indicate their sockets. Red sockets are live. Blue
sockets are ground.

On switches and relays, red sockets are normally closed, black sockets are normally open, and
blue sockets are common.

2. Point the mouse on the first socket, the socket turns green indicating a connection can be made.
3. Click the mouse. A light blue arrow now appears, indicating a socket has been selected.
4. Bring the mouse to the second socket. The socket turns green.

The path will be indicated by an aqua line as you drag the mouse to the second port.

Optional: you may route the connection between sockets. Click the mouse to make right angle
turns along the path. Aqua-colored lines mark the path as you create it. You can use this option
to route lines around a component.

T —r]
Wi =)

5. Click the mouse. The line turns red, indicating the connection has been made.

5 Connections
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5.1.3. Deleting one Connection
To delete a connection do the following:

1. Point the mouse on the line you want to delete. Do not click. The connection will blink and
change color.

2. Press [Del], the connection will be deleted.

5.1.4. Deleting All Connections

To delete all of the connections do either of the following:

e Select Connections | Delete All Connections.
OR

e Click on the Delete All Connections button.

All connections are deleted.

5.1.5. Erasing an incomplete Connection
To erase a partially complete connection, press [Del].

The line is deleted.

5.1.6. Changing the Second Port of a Connection
To change an existing connection, do the following:

1. Place the mouse on the line you want to delete. The connection will blink and change color.
2. Click on the line you want to change.

3. The line changes color. The second port is disconnected while the first port remains selected.
4. Click on the port you want for the new connection.

The new connection is displayed.
5.1.7. Exiting the Connections Window
To exit the Connections window, do either of the following:

e C(Click on the Close Connections button.

OR

e Press [Esc].

The dot grid disappears and you can perform other operations on you circuit diagram.

5 Connections
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5.2. LINKING PUSH BUTTONS

For safety reasons, a hydraulic circuit may require simultaneous (two handed) operation of two push
buttons. Since you can only click one button at a time, the push button link option allows you to
simulate simultaneous, two-handed, activation of the push buttons.

Push button links can be made only when the Cross-Section display mode is active. These links cannot be
made when the Connections or Schematic mode is active. The links can, however, be removed when any
display mode is active.

To link two push buttons, do the following:

1. Select Connections | Link PBs.

You are prompted to select the master push button. The master is the push button which
controls both push buttons.

2. Click on the PB that you want to serve as the master.
The letter M is now displayed inside the component.

You are prompted to select the slave push button. The slave is the push button which is
controlled by the master.

3. Click on the push button that you want to serve as the slave.

The push buttons are now a linked pair, as indicated by an identical digit (e.g., M1 and S1)

When you activate the master push button, the slave button is also activated. However, the slave push
button remains operable on its own.

5.2.1. Disconnecting One Pair of Linked Push Buttons
To disconnect the links between a selected pair of push buttons do the following:

1. Select Connections | Link PBs. Lines appear showing all pairs of linked push buttons.
2. Place the mouse on the line you want to delete. Do not click.
3. Press [Del], the connection will be deleted.

5.2.2. Disconnecting All Push Button Links

To disconnect the links between all push buttons select Connections | Clear PB links.

5 Connections
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All push button links are removed.

5.3. LADDER DIAGRAMS

5.3.1. Creating a Ladder Diagram

You can make electro-hydraulic connections by means of a ladder diagram.
To create a ladder diagram, do either of the following:

e Click on the Edit Ladder Diagram button.
OR

e Select Connections | Create ladder Diagram. The Create Ladder Diagram window opens.

*= HydraMotion [= & |5
File Edit View Components Connections Simulation  Interface  Window Help
2 N ¥ & X
5| Create Ladder Diagram ==
s g &— 1
PEl N.0O
—a E—
YT T T T T T
- |
A+J\rA—J\rB+J\rE—J\rC+J‘\J_C—J\I i‘

al N.0 | al N.0 (b0 N.0O | bl N.0 |cl N.0O | cl N.O

al N.C | al N.C (b0 N.C | bl N.C |cl N.C |cl N.C

LAMP1 | LAMPZ | LAMP3

CR CR1 N.0O|CRZ N.0|CR3 M.0 |[CE4 N.O
-

CRl N.C|CR2 N.C[CR3 N.C|CR4 N.C

THR1 [MELl N.OFE1 N.O0|PEZ N.0|PE3 N.O
_O-l [ME1 N.C/FEl N.C|PEZ N.C|PE3 N.C
CTR1 CTRL . 0|
_O-| CTRL HN.C
a
[ [caPs R [REC |

5.3.2. Creating a Circuit from a Ladder Diagram

The Create Ladder window has two parts. The top half shows the ladder diagram, the bottom half shows
a table of electro-hydraulic components. (Components whose names appear in black have been placed in
the drawing area and can be connected in a circuit).

To connect components by means of the ladder diagram, do the following:

1. Click on a black component in the table.

The cell will turn white, and the cursor changes to a boxed +.

5 Connections
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2. Click on the ladder diagram rung where you want to place the component.

The component now appears in the ladder diagram

Use the buttons at the top of the window to make, change or delete the connections.

3

7]

AN

il

[

Checks the connections.

If a connection or component turns red the connection is
faulty. If nothing happens, the connection is OK.

Even though the connections test is successful the actual

components on the panel may not be properly connected.

Connects Components. When selected, the cursor turns
into a wand.

Black lines indicate a connection. Click on the blue lines to
turn them black (connect).

Deletes components or connections. When selected, the
cursor turns into a wire cutting tool.

Place the cursor on the connection or component you want
to delete, and click.

Moves a rung in the ladder diagram down one line. When
selected, the cursor turns into a shaded square.

Place the cursor on the rung you want to move, and click.
The rung moves down one line.

Saves the connections made in the ladder diagram and
exits to the main window.

All connections make in the ladder diagram now appear in
the circuit diagram.

Closes the Create Ladder Diagram window without saving
the new connections.

Any connections made in the ladder diagram will not
appear in the circuit diagram.

5 Connections
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6. Views

The View menu allows you to select the manner in which the components are displayed. Two basic
display modes are available:

e (Cross-Section
e Schematic

The Zoom In and Zoom Out options can be used when either display mode is active.
In addition, the view menu allows you to display two types of diagrams:

e Ladder Diagram
e Parameter Diagram

6.1. CROSS SECTION DISPLAY

The Cross-Section display mode provides a cross-section illustration of the components, as shown in the
picture below. The different colors allow you to see the different elements of each component.

The cross-section allows you to observe the following:

e QOperation of the circuit and components.

e Simulated hydraulic pressure flowing through the connections and its effect on the various
components.

e The component’s reactions to changes in pressure.

6.1.1. Activating the Cross-Section Display Mode

[2]

To display the Cross-Section mode, do either of the following:
e Select View | Cross-Section
OR

e Click on the Cross Section Button

6.2. SCHEMATIC DISPLAY

The Schematic option displays the components in standard schematic form, as shown in the picture
below. This display mode is useful for observing and analyzing components in a pneumatic circuit or
complex system.

6 Views
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The Schematic display mode is for viewing purposes only. Simulation or connections cannot be

performed in this mode.

6.2.1. Activating the Schematic Display Mode

[]

To display the Schematic Mode, do either of the following:

e Select View | Schematic
OR

e Click on the Cross-Section button

6.2.2. ZoomIn
e

To zoom in do the following:

1. Select View | Zoom In, or Click on the Zoom in Picture button.

The Choose Screen dialog box opens.

Choaose Screen ﬁ

Selected

Zoom area xCancel

2. Arectangle is attached to the cursor. Move the rectangle to select the part of the screen you
want to enlarge, and click the mouse.

6.2.3. Zoom Out

To Zoom out, do the following:

e Select View | Zoom Out

6 Views
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OR

e Click on the Zoom Out Picture button.

The circuit diagram returns to its normal view.

6.3. PARAMETER DIAGRAM

The parameter diagram monitors pressure and flow during circuit operation. The parameter diagram

provides the user with a graphical view of pressure and flow in a hydraulic circuit.

3= Hydrahotion =n =R
File Edit “iew Components Connections Simulation Interface ‘Window Help
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6.3.1. Activating the Parameter Diagram

To view the time diagram, do one of the following:

e Select View | Parameter Diagram

OR

e Click on the Monitoring button

[caPs [ovR TRET
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6.4. LADDER DIAGRAM DISPLAY

A ladder diagram is a schematic control flow chart for electro-hydraulic circuits. It is automatically
generated by the software according to electrical connections you make in the diagram.

6.4.1. Displaying the Ladder Diagram

To display the ladder diagram of the circuit diagram in the currently active window, do either of the
following:

e Select View | Ladder Diagram
OR

e Click on the Display Ladder Diagram button. The Ladder Diagram window opens.

# | Ladder Diagram = [ B[]
i @

Ch 23 4,:"“‘ B_H_I I
— E oy

2 4/ 3CAIE

6.4.2. Closing the Ladder Diagram

e

To close the ladder diagram, click on the Exit Ladder Diagram button, or use any standard Windows
method for closing a window.

6 Views
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7. Simulation

The simulation mode allows you to observe the operation of a component working independently or as
part of a whole circuit.

Simulation is available only when the Cross-Section display mode is in effect.

7.1. SINGLE COMPONENT SIMULATION

You can simulate the operation of a single component in four ways:

e Automatic step by step. This simulation displays continuously changing states of the selected
component.

e Automatic continuous. This simulation will show continuous operation of the selected
component.

e Manual step by step. This simulation shows each state of the selected component one at a
time. You must continuously click the component to display each state.

e Manual continuous. This simulation will show the continuous operation of the selected
component. You must continuously click the component to make the simulation progress.

The automatic continuous and manual continuous options are not available for all components.

7.1.1. Simulating a Component Automatically
E To automatically simulate a single component, do the following:
1. Select the component you want to simulate.

2. Select Simulation | Component and then select one of the two
automatic simulation modes.

Clicking the tool bar button activates the Single Component simulation Auto
Stepped mode.

7.1.2. Simulating a Component Manually
To manually simulate a single component, do the following:
1. Select the component.

2. Select Simulation | Component and then select one of the two manual simulation modes.

3. Click on component to change the state or progress of the component.
7.1.3. Stopping the Simulation of Single Components

.E! Exit the simulation mode to make changes in the circuit diagram.

To stop the component simulation, click on Exit from Single Component Simulation
button.

The normal viewing mode is resumed.

7 Simulation
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7.2. CIRCUIT SIMULATION

m HydraMotion allows you to simulate the operation of an entire circuit.
To view the simulation of an entire circuit, do one of the following:

e Select Simulation | Circuit.

OR

e  Click on the Simulate Circuit button.

Once you are in the simulation mode, you can click on any push button that is in
the diagram to see how they will affect the hydraulic circuit.

7.2.1. Stopping the Circuit Simulation

m To stop the circuit simulation, click on the Exit from Simulate Circuit
button.

The normal viewing mode is resumed.

7 Simulation
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8. File Management

HydraMotion files are managed through the standard Windows file tools, found in the File menu.

New [Ctrl]+N | Opens a new, untitled file.

[[cersovRREC |

| Open  [Ctrl]+O | Opens a dialog box for selecting an existing circuit
diagram file.
| Save [Ctrl]+S | Saves the currently active file.

If the file is untitled, a dialog box opens for defining the
file name. By default the system provides a file name
(e.g., HY0012.BIN). You may give the file any title you
want.

8 File Management

7.2 Circuit Simulation 34



Intelitek»»

Dynamic Solutions, Inspired C

assrooms

| Save As

| Print [Ctri]+P

| Delete...

Exit

Saves the currently active file under a new file name.

The Save File dialog box opens. Enter a new name in
the Title field. By default the system provides a file
name (e.g., HY0012.BIN).

Prints the currently active file.

Opens a dialog box with a list of previously saved files.

Choose a file that you want to delete and click OK.

Delete a selected file

Title File Date o huser
simple electric . Directories
4-3 valve and two lamps II
fully automatic [ £

Charging accumulator
2 hand operated

Remote operated valve

two cylinders

Non return valve

LCancel

16-/02-99

Driwes
Ch A

Quits HydraMotion.

If changes have been made to a file, but not yet saved,
a warning message is displayed.

8 File Management
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9. System Setup

9.1. PROGRAM WINDOWS

The Window menu contains Windows commands for the display of the program windows.

]ILI |Open Main Window | Opens a new main window.
This command functions the same as File | New.
]ﬁl |Close Main Window | Closes the active main window. If changes have been
made, but not yet saved, a warning message will be
displayed.

The button toggles between open and close. It opens a
window if one is not currently active, and closes a window
if one is currently active.

SEs| Open 2nd Window | Opens a new second window.

The second window will open under the main window. It
functions in the same way as the main window. It can be
moved and resized.

Only the main and 2nd windows can be open at the same
time in HydraMotion.

E—hl Close 2nd Window Closes the active second window. If changes have been
made, but not yet saved, a warning message will be
displayed.

The button toggles between open and close. It opens a
window if one is not currently active, and closes a window
if one is currently active.

|Cascade | The usual Windows control for resizing and layering open
windows so that each bar is visible.

|Ti|e | The usual Windows control for resizing and arranging the
open windows by size.

|Arrange Icons | The usual windows control for realigning the icons of
programs that have been minimized.

|Close All | Closes all open windows that are used for program editing.

The Cascade or Tile setting remains in effect until changed.

9.2. ON-LINE OPERATION

HydraMotion can be used to control actual electro-pneumatic circuits and to provide graphic tracking of
the HydraFlex laboratory panels.

The CIC Unit (PLC Micrologix) is required for the software-hardware interface. Refer to the
documentation provided with the panel and the CIC Unit (PLC MicroLogix) for installation instructions.

9 System Setup
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For information on how to configure the PneuMotion software when working in online operation, see:

e Configuring the Software for Online Operation (PLC MicrolLogix)

9.2.1. Configuring the Software for Online Operation (PLC MicroLogix)
To configure the software for on-line operation, do the following:

1. Make sure the computer, the panel; the PLC Micrologix and the power supply are all properly
connected, as shown in the example below.

1 PLC MicrolLogix

2 PLC to Power Supply
Cable

3 Power Supply
Connections

4 Power Supply Cables
(Red and Black) to
Electrical Distributer

5 Electrical Distributer

6 Double Acting Cylinder
with Magnetic Sensors

7 4/3 Sol-sol Control
Valve

8 Inductive Proximity

PLC MicroLogix Connected to Power Supply and Panel

2. Use HydraMotion to load or draw an electro-hydraulic circuit, which is (or will be) assembled on
the HydraFlex panel.

The figures below show an example of the same circuit drawn in HydraMotion and when set up
on the HydraFlex panel.

"

1

E ! AP/ B T ! 1
pb 1 ’—‘ -
P2
! «
No HC o e
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3. Select Interface | Setup. The Setup dialog box opens. This box allows you to select the
components that are controlled and tracked by the software.

Setup =
Controller Configuration |
| | Output | Ihput | Ch
FORCE 413 Sol all 1
R Ok
FORCE 4!3 Sol al 2
FORCE sal-spring | FBI 3
212
FORCE Lampl | PB2 4 xCanceI
PBL i
PBG 8
PBY 9
PBS 10

All electrical input and output connections made in the circuit diagram are available in the Setup
dialog box.

4. Using the check boxes, select the components which will operate online.

Once components are selected online operation, they respond to external I/0 signals only.
HydraMotion graphically tracks the operation of these components (and does not simulate their
operation).
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5. Click the Controller Configuration button to connect the HydraMotion software to the PLC
MicrolLogix. The following configuration window is displayed.

CitnQuest IN-GEAR AR Standard Edition Configuration

—Settings
— Hardware — Communications
Adapter |1 vl ¥ Enabled Command Set IDH-485 ;I Apply

DeviceT ype ISeriaIDF'l ,I Link Speed |'|9.2k v| Cloze

Cornm Part Checksumn * CRC (" BCC

[

i I— About...
EBaze Address I coon - I Timeout 4000

/0 Port o - Station |0 IDD v|
tax Modes IDD v|
Term. Mame I

BIM Files... | |

6. From the Comm Port drop down list, select the required COM port and click Apply.
7. Click Close. A confirmation message is displayed.

8. Click Yes. A message is displayed requesting you to restart your application. Click OK.
9. Restart the HydraMotion application.

10. Select Interface | COM Test to communicate with the controller. One of the following options
will appear on the status bar on the bottom right hand corner of the window:

] : Indicates the HydraMotion is communicating with the PLC MicroLogix controller.

REC : Indicates no communication exists between the HydraMotion software and the

controller. In this case check your controller configuration.

9 System Setup
9.2 On-Line Operation 39



	1. Introduction
	2. Installation and Activation
	2.1. System Requirements
	2.2. Installing the Software
	2.3. Uninstalling the Software
	2.4. Activating the Software
	2.5. Quitting the Software

	3. Overview
	3.1. The HydraMotion Window
	3.2. File Menu
	3.3. Edit Menu
	3.4. View Menu
	3.5. Components Menu
	3.6. Connections Menu
	3.7. Simulation Menu
	3.8. Interface Menu
	3.9. Window Menu
	3.10.  Help Menu

	4. Components
	4.1. Selecting Components
	4.1.1. The Component List
	4.1.2. The Component Library

	4.2. Manipulating Components
	4.2.1. Moving Components
	4.2.2. Rotating Components
	4.2.3. Flipping Components
	4.2.4. Mirroring Components
	4.2.5. Resizing Components
	4.2.6. Copying Components
	4.2.7. Deleting Components
	4.2.8. Adding Text

	4.3. Component Parameters
	4.3.1. Editing Component Parameters


	5. Connections
	5.1. Connecting Components
	5.1.1. Making Pneumatic Connections
	5.1.2. Making Electro-Pneumatic Connections
	5.1.3. Deleting one Connection
	5.1.4. Deleting All Connections
	5.1.5. Erasing an incomplete Connection
	5.1.6. Changing the Second Port of a Connection
	5.1.7. Exiting the Connections Window

	5.2. Linking Push Buttons
	5.2.1. Disconnecting One Pair of Linked Push Buttons
	5.2.2. Disconnecting All Push Button Links

	5.3. Ladder Diagrams
	5.3.1. Creating a Ladder Diagram
	5.3.2. Creating a Circuit from a Ladder Diagram


	6. Views
	6.1. Cross Section Display
	6.1.1. Activating the Cross-Section Display Mode

	6.2. Schematic Display
	6.2.1. Activating the Schematic Display Mode
	6.2.2. Zoom In
	6.2.3. Zoom Out

	6.3. Parameter Diagram
	6.3.1. Activating the Parameter Diagram

	6.4.  Ladder Diagram Display
	6.4.1. Displaying the Ladder Diagram
	6.4.2. Closing the Ladder Diagram


	7. Simulation
	7.1. Single Component Simulation
	7.1.1. Simulating a Component Automatically
	7.1.2. Simulating a Component Manually
	7.1.3. Stopping the Simulation of Single Components

	7.2. Circuit Simulation
	7.2.1. Stopping the Circuit Simulation


	8. File Management
	9. System Setup
	9.1. Program Windows
	9.2. On-Line Operation
	9.2.1. Configuring the Software for Online Operation (PLC MicroLogix)



